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All information and specifications written or implied in 

this manual are current at the time of release.  However, 

due to the ongoing process of adding improvements to the 

product, PowerTronics / Eastern Time Designs, Inc. 

reserves the right to make changes at any time without 

notice. 

 

 

Copyright 2009 
PowerTronics 

EASTERN TIME DESIGNS, INC. 

SAFETY NOTICE 
 

The power cable attached to the device is 

supplied with a safety and reference ground.  Do 

not use the PQR 2020 when powered from an 

ungrounded outlet. 

 

High voltage exists at many points inside the 

cabinet.  Qualified personnel ONLY! should 

open the covers. Opening the covers may affect 

the warranty. 
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18 MONTH WARRANTY 

Eastern Time Designs, Inc. (PowerTronics) warrants to the original retail purchaser 

that each PQR Series 2020 Power Line Monitor sold by PowerTronics or any 

authorized representative is free from defects in material and workmanship for 18 

MONTHS from the date of purchase. 

In the event of malfunction or other indication of failure attributable directly to 

faulty workmanship and/or materials, Eastern Time Designs, Inc. (PowerTronics) will 

at its option, repair or replace the defective product, to whatever extent it shall deem 

necessary to restore the product to proper operating condition, provided the purchaser 

includes proof of the date of purchase of the product along with the defective product. 

Please note that Eastern Time Designs, Inc. may replace the defective product with 

a new or re-manufactured functionally equivalent product of equal value. 

When returning a product for repair, be sure to include the customer's mailing 

address, email address and telephone number . Products should be returned to: 

 

PowerTronics 

Attention: CUSTOMER SERVICE DEPARTMENT 

143 Raymond Rd. 

Candia, NH 03034 

During the first 18 months after the date of purchase all labor and materials will be 

provided without charge. There will be no warranty for either parts or labor after the 

expiration of 18 months from the date of purchase. 

The customer shall be solely responsible for the failure of any Eastern Time 

Designs product or component thereof resulting from accident, abuse or misapplication 

of the product, and Eastern Time Designs assumes no liability as a consequence of 

such events under the terms of this warranty. Some states do not allow the exclusion of 

implied warranties, so the above exclusion may not apply to you. This warranty gives 

you specific legal rights and you may also have other rights which vary from state to 

state. 
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INTRODUCTION 
This reference guide is designed to aid users of the PQR 2020 in the interpretation of AC power 

line problems. 

The PQR 2020 Power Line Monitor is made in the U.S.A. by PowerTronics.  This unit 

incorporates the latest technology in surface mount assembled circuit boards to provide the user with 

detailed information describing the power line.  It will detect a wide range of disturbances including 

dropouts, power failures, sags, surges, impulses, high frequency noise, and common mode noise on 

the three phases of AC voltage and the Neutral line.  The PQR 2020 monitors these disturbances and 

records them, along with a data log of channel readings at user selected intervals, in non-volatile 

FLASH RAM for future access. 

Electronic equipment is damaged more often by power 

disturbances than by fire, theft, and vandalism combined. 

Intermittent power problems are the most expensive, hidden cost to 

the owners of microprocessor-based equipment. It is therefore 

essential that power supplies be properly tested to insure that no 

such damage occurs. 

The PQR 2020 is easy to use and provides immediate and long-

term information for the technician and customer to understand 

power line disturbances. It is an important tool for installers of 

electronic equipment, service technicians, medical facilities’ technicians, or anyone that needs to 

identify the power quality of a particular site. 

The PQR 2020 is one of a series of practical power line monitors, designed and priced to be 

outfitted to everyone who services or installs three-phase electrical and electronic equipment.  We 

believe that the PQR 2020 Power Line Monitor is one of the most cost effective and practical power 

line monitors on the market. Look for more advanced diagnostic products from PowerTronics 

(Eastern Time Designs, Inc.) in the near future. 

To monitor the three phases of AC line voltage with the PQR 2020, connect the test leads 

between the circuits to be tested and the three phase  and Neutral inputs located on the back of the 

unit.  Then plug the power cord provided with the unit into a standard 110 volt or 220 volt outlet.  

After running an internal self test, the unit will start testing the three phases and the Neutral  lines.  It 

is recommended that the unit test the three phase power source for at least a 24 to 72 hour period. 

After testing is completed simply attach the PQR 2020 to a computer to access the data via USB 

or RS232 serial communications.  The summary, detail, and data log reports can then be examined 

and used in the rendering of graphics using the PowerTronics PQR Host Communications Software 

or a similar terminal emulation software. 
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CALIBRATION 
 

The PowerTronics Power Quality Recorders are designed to test the Power Line with a 

high degree of accuracy. In this unit all measurements are referenced to a state of the art, 

temperature compensated voltage source. It is recommended that each unit be calibrated 

annually by the factory as certain components may require periodic calibration. The 

procedure typically takes seven days and will be provided upon request for a nominal fee. 

 

Mention CALIBRATION PROCEDURE when calling for an RMA number. 
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OVERVIEWOVERVIEWOVERVIEW   

The PQR 2020 Power Line Monitor is a state of the art, fully integrated instrument which 

measures, records, and reports power disturbances, aiding in the analysis of power quality for 

Three Phase AC power in medical, commercial, and industrial applications. 

Power disturbances detected on multiple 

channels are recorded by their time, date, and 

magnitude in non-volatile FLASH RAM 

memory.  This data is then retrieved from the 

PQR through its serial communications port. 

The PQR 2020 continuously data logs the 

voltages on the three AC Phases and Neutral 

line.  This data is then stored in memory, 

independent of the disturbances.  The unit's Data 

Logger will log these readings at the interval 

length selected by the user. 

 

Connections to the PQR 2020 are 

made between the safety connectors on 

the back of the unit and the circuit 

being tested.  The power to operate the 

unit comes from any 110/220 volt, 

15/20 amp AC power supply.  Once 

plugged in, the PQR 2020 immediately 

begins testing the signals on the testing 

inputs.  The unit comes equipped with a 

power cord for plugging into a standard 

110 volt, 15/20 amp AC outlet.  

Adapter cables (or Patch Cords) are 

available from PowerTronics in order 

to allow the unit to be powered off of 

other style, voltage, and/or amperage 

outlets.  The unit may also be powered 

by DC voltages of 9 to 24 volts 

Graphics SoftwareGraphics SoftwareGraphics Software   IncludedIncludedIncluded!!!   
 

The 

PQR HostPQR HostPQR Host   

CommunicationsCommunicationsCommunications   

SoftwareSoftwareSoftware   

is provided with the 

PQR 2020PQR 2020PQR 2020   

 
Software Features: 

 Download data from the PowerTronics PQR Series monitors 

 Generate Summary Report PIE CHARTS of disturbances 

 Create Detail Report HISTOGRAMS of all events detected 

 Plot Data Log LINE CHARTS of the Channel Readings 
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MMMONITORONITORONITOR   3 P3 P3 PHASEHASEHASE   AC PAC PAC POWEROWEROWER   
(Three Phase + Neutral AC Line Voltage)(Three Phase + Neutral AC Line Voltage)(Three Phase + Neutral AC Line Voltage)   

FEATURES 

 User-Friendly 

 Minimal Setup Time 

 Made in the USA 

 Eighteen Month Warranty 

 Non-Volatile Memory 
(Flash RAM - 20 year Data Retention 

Guaranteed at 125º C without power) 

 Multi Phase Monitoring 

 Continuous Data Logging of AC Voltages 

(3 Phases + Neutral) 

 Continuous Disturbance Detection on all four AC 

Voltage inputs 

 Programmable Sampling Rates and Disturbance 

Thresholds 

 Fast Impulse Detection 

 Serial Communications port for easy connection 

to a Computer or Terminal 

 Easy to Understand Reports 

 Comes complete with Communications and 

Graphics Software designed for the unit 

Simple to operate: 

 Connect the test leads to a service 

panel and the unit 

 Plug the power cord into a 

grounded outlet 

 Periodically connect to the unit to 

a computer for reports 

Stores events in non-volatile Flash RAM: 

 Over 32,000 Total Events recorded! 

 Stores over 32,000 Data Log Entries! 

(or one data log reading every minute for over 

22 days) 

Measure all types of Power 

Disturbances: 

 Dropouts 

 Power Failures 

 Sags 

 Surges 

 Impulses 

 High Frequency Noise 

 Common Mode Noise 

 Frequency/Phase Deviations 
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SIGNAL TESTING 
Power Up Procedure 

Applying AC Power 

The main power to operate the unit comes from any standard 110/220 volt, 15/20 amp AC voltage 

supply provided through the AC connector located at the back of the unit.  The unit comes equipped 

with a power cord for powering off of a 120 volt, 15 or 20 amp outlet. 

When the PQR 2020 is first connected to AC power (110 V AC or 220 V AC), it will go through 

a series of power on diagnostics.  The status of these tests can be seen in the Unit Status LED.  As 

soon as the diagnostics have completed, the PQR 2020 is on-line and monitoring the input channels.  

Simply leave the PQR 2020 plugged in with the voltages to be tested attached to the three AC input 

channels and the Neutral channel as will be described in the following pages. 

After testing connect the PQR 2020 to a PC using a null modem cable attached to the USB or 

RS232 serial communications port.  The PowerTronics PQR Host Communications Software (or a 

similar program) can then be used to download all the necessary data from the unit and render the 

text-based reports into graphical presentation formats 

Applying DC Power (optional) 

The PQR 2020 has a DC Power Input connector for running off a DC power supply.  The most 

common use of this power option is for allowing the unit to continue functioning off battery power 

even after a massive power failure has hit the test site.  The connection is made using a standard 

Female DC Connector with outer/inner diameters of 5.5/2.1 mm.  The outer shell must have the 

positive voltage.  Note that when using the DC power supply option it is essential that the AC power 

cord still be attached as it supplies the safety and reference ground.  The source can be 9 to 24 V DC. 

Unit Status LED 

The Unit Status LED is located on the front panel of the PQR 2020.  It indicates system 

diagnostics status and Channel operational status. 

While the initial tests are being executed (approximately 15 seconds) the LED will blink.  After 

the tests are completed, it will turn off briefly, and then turn on steady.  The LED will also blink for 

fifteen seconds whenever a disturbance is detected on any input or the serial port has been accessed. 

 

The recommended testing time is 24 to 72 hours in order to determine the suitability of an outlet 

for powering electronic equipment. 
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Testing AC Voltages - Connecting 

The PQR 2020 Three Phase Voltage Power Line Monitor is designed to obtain the maximum 

amount of useful data from the circuits under test, while requiring the minimum amount of setup 

time.  It is capable of analyzing the power on Three Phases and a Neutral channel of AC voltage. 

All signals to be tested are applied to the four test input banana jacks located on the back of the 

PQR 2020.  There is one jack for each phase and one for the Neutral.  The phases are applied to the 

Red Jacks while the Black Jack is reserved for Neutral.  Data from the four input connector starts 

being collected as soon as power is applied to the AC power connector (or alternate DC power 

connector) located on the back of the unit. Data will continue to be gathered until the unit is 

unplugged.  Note that all signals are referenced to the safety ground of the unit.  The unit MUST have 

this safety ground.  (Plugging the PQR 2020 into a grounded outlet using the supplied AC Power 

Cord will take care of this.) 

To test one or more of the AC phase lines simply connect the supplied PowerTronics Test Leads 

between the PQR 2020 input jacks and the Service Panel using the following procedure: 

 Connect the Safety Banana Plug of the Black Test Lead to the Black 

Neutral input jack on the back of the PQR 2020 

 Connect the Alligator Clip of the Black Test Lead to the NEUTRAL BAR 

on the Service Panel 

 Connect the Safety Banana Plug of a Black Test Lead to the Black Phase 1 

input jack on the back of the PQR 2020 

 Connect the Alligator Clip of the Black Test Lead to the first phase to be 

tested on the Service Panel.  USE CARE!!! 

 Follow the same procedure for Phases 2 and 3 if so desired.  USE CARE!!! 

DANGER! HIGH VOLTAGE! 
 

The Voltages you are testing can KILL! 

Only a Certified Electrician 

can connect the test leads to a distribution panel. 

 

Please use Care! 
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Testing AC Voltages - Monitoring 

Long term voltage recording is known as Data Logging.  The PQR 2020 samples the voltage on 

each of the 4 AC inputs continuously and stores the average readings once each minute (or at the 

sampling interval the Data Logger is set to).  There is enough data storage capacity in the unit to 

collect over 32,000 of these readings.  When the Data Logger is set to one minute intervals this is 

equivalent to over 22 days of voltage readings on all four channels. 

The PQR 2020 will continuously test the three phase voltage inputs and Neutral line for Dropouts, 

Power Failures, Sags, Surges, Impulses, High Frequency Noise, and changes in Line Frequency and 

Phase.  Any power quality problems that exceed the preset thresholds will be recorded in the Flash 

RAM, with the time and date stamp of the event.  There is enough data storage capacity in the unit to 

collect over 32,000 disturbance events total between all 4 channels. 

 

Additional information with regards to the data storage and event detection capabilities for the 

four AC Voltage testing channels of the PQR 2020 is supplied in the Specifications Section of this 

manual. 
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SERIAL COMMUNICATIONS 

Connecting to the PQR 2020 

DIRECT: 

The serial port connector on the front panel of the PQR 2020 is a 9 pin DB style RS232. The pinout 

is as follows: 
 

Pin 2 Receive Data 

Pin 3 Transmit Data 

Pin 5 Ground 
 

A Null modem cable must be used to establish a connection between this port and a PC. This type 

of cable connects the Transmit Data pin on the PC to the Receive Data pin on the PQR, and the 

Transmit Data pin on the PQR to the Receive Data pin on the PC. It also connects the Ground pins 

together. 

The PQR 2020 is configured to operate at 19,200 baud (factory default), with 8 data bits, 1 stop bit, 

and no parity checking. Select Xon/Xoff Communications protocol. 

MODEM: 

Use a straight cable (not a null modem) when connecting to a modem. 

Power the PQR 2020 and the Modem up at the same time after connecting the cable.  The PQR 

2020 will auto configure the Hayse compatible Modem for auto answer mode, at 19,200 baud (or 

present baud rate setting). If the modem is not Hayse compatible, configure it to answer the phone 

on 2 rings, with a Baud rate of 19,200 (or current setting), 8 data bits, 1 stop bit, and no parity 

checking. 

COMMUNICATIONS SOFTWARE: 

The PQR Series 2020 can communicate with a PC using programs such as the PowerTronics PQR 

Host Communications Software and HyperTerminal.  Note that such programs will provide a 

means of directly downloading the data in a text file format. This data can then be employed by the 

user in the generation of graphical plots and charts as needed.  The PQR Host Communications 

Software is specially designed to facilitate the easy creation of these graphical representations of 

the data gathered by the PQR 2020.  The following pages will deal with its installation and use.  

Discussion will also be made about more general commands useable through basic 

communications programs such as HyperTerminal. 
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PQR Host Communications Software 

Introduction: 

This section of the manual is designed to aid PQR users in the use of the PowerTronics PQR Host 

Communications Software available with their unit in order to maximize the ease of the interpretation 

of AC and DC power line disturbances as well as environmental problems. 

The PQR Host Communications Software is designed to work with the PQR Series of Power Line 

Monitors, which are portable diagnostic instruments designed to monitor AC and DC Power Lines, 

analyze and capture disturbances, and record these disturbances for later retrieval. The PQR Host 

Communications Software is also capable of working with other PowerTronics product lines such as 

the PDL Series Data Loggers and units in the DETECTIVE SERIES line that have been designed and/or 

modified for Windows compatibility. See the PowerTronics Product Support page for the most recent 

list of PowerTronics units that are supported by the PQR Host Communications Software. 

Made in the U.S.A. by PowerTronics, the PQR Series Monitors incorporate the latest technology 

in their surface mount assembled circuit boards to provide the user with detailed information 

describing all types of power line and environmental disturbances. Once detected, the PQR Series 

monitors will record the most important information about these events, such as the event type, the 

event magnitude, the time and date of the occurrence, and the channel it occurred on. This 

information is stored in FLASH RAM, where it is formatted into an easily read format that may be 

downloaded to your computer for display or printing. This format is also designed to be used directly 

with the PowerTronics PQR Host Communications Software. 

When testing a power site, it is recommended that you test the power source for a period of at 

least 72 hours. After testing, attach the PQR Series monitor to your computer through the serial 

communications port on the unit, start the PQR Host Communications Software program, and scroll 

through the list of functions to choose the report or display you need. 

The PQR Host software program will provide you with a listing of disturbances and channel 

readings in summary, detail, or data log form. The disturbances are recorded as individual events 

which are analyzed according to their magnitude, time, date, and channel. The Data Log of each 

channel can also be displayed on your computer monitor or printed to a local printer. In addition, the 

Data Log data can be zoomed in on using the PQR Host Software to highlight any areas of concern. 



PQR 2020PQR 2020PQR 2020   
Page   15 

www.PowerTronics.com 

Software Overview: 

The PowerTronics PQR Host Communications Software is provided with the PQR 2020.  When 

the PQR 2020 is connected to a computer via a null modem cable, the PQR Host Software provides 

several functions to the user: 

 Automatically connects to the PQR 2020 

 Allows the user to configure the Settings of the PQR 2020 

 Downloads data from the PQR 2020 and saves it directly to the computer 

 Generates Reports, Charts, and Graphs from the downloaded data 

(Note that not all functions of the PQR Host Software are available to every unit.) 
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Installation Procedure: 

Go to www.PowerTronics.com, click on the support link, and download the latest version of the 

software or place the Software Installation CD provided with your unit into the CD drive on your 

computer. 

Select or Double click on the SETUP file.  A series of installation setup files will then be copied 

to your computer’s memory.  The installation program will then initiate the installation and display a 

window with the following: 

To prevent any software conflicts, you should close any other applications or programs running 

before continuing with the PQR Host Communications Software installation.  Then click the OK 

button depicted in the window above. 

Note that the installation processes can be terminated at any time simply by pressing the Exit 

Setup button.  The installation software will then confirm that the user wishes to abort the installation 

procedure and will then proceed to delete the installation setup files previously placed on the system.  

The user will be notified upon completion of these tasks. 
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To proceed directly to the installation and use the default directory for the destination of the 

software, simply click on the Computer Icon button shown in the above window image.  

Alternatively, selecting the Change Directory will allow the user to choice the desired location on 

the computer system for the software installation.  Once an alternate location has been specified 

simply press the Computer Icon to proceed.  Note that the location that will be used for installation 

is shown to the left of the Change Directory button. 

Once the user has selected the OK button the installation software will proceed to the destination 

directory window depicted below. 

The installation program will then 

proceed to the window shown on the left. 

This stage allows the user to select the 

Program Group under which the software 

will be placed.  By default, the installation 

software uses the PowerTronics Group.  

Click on another to change to that group. 

When complete click Continue.  This 

will allow the Software to be installed.  The 

installation program will notify the user 

once the installation procedure has been 

successfully completed. 

The PQR Software can be uninstalled 

using the Add or Remove Programs utility. 
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Accessing the Software: 

Now that the PowerTronics PQR Host Communications Software has been successfully installed, 

the program can be used to communicate with the PQR Series units and to provide graphical analysis 

of the gathered data. 

Note that to facilitate speedy access of the PQR Host Software a shortcut can be created on the 

desktop.  This is accomplished by right clicking on the PQRHost from the above listing.  Select the 

COPY command and then PASTE to the desktop.  This icon can now be used to start the PQR Host 

Software in addition to the method described above. 

 

The following pages will outline the use of the software to communicate with the unit and analyze 

the data transmitted. 

To run the PQR Host Software: 

Click on the START button 

Select Programs 

Select POWERTRONICS 

(Assuming default grouping was used in installation) 

Select PQRHost from the list 
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Operating the PQR Host Software: 

The PowerTronics PQR Host Communications Software is a graphical interface, Windows-based 

program.  The main tasks in the operation of the software are performed through the use of pull-down 

menus located at the top of the main window.  The following provides a summary of these menus 

which are described in more detail on the following pages. 

File 

The File menu contains options for 

using data files that are stored on the 

computer hard drive or a disk. 

Edit 

In the Edit menu are some of the 

standard text editing options.  Only 

available when a text report is open. 

View 

The View menu provides items used to 

control what tools are visible and 

available to the user in the main program 

window.  These items can aid the user in 

the operation of the PQR Host Software. 

Settings 

The Settings menu contains items that allow the user to specify certain settings for communication 

between the software and the PQR device.  The menu also provides an interface for setting the 

internal PQR device parameters. 

Communications 

The Communications menu contains items that allow the user to retrieve data from the device.  It 

also allows for the clearing of the unit and checking for proper channel operation.  Along with the 

Graph menu, the Communications menu composes the core of the PQR Host Software. 

Graph 

The Graph menu lists the graphical representation options available to the user for the creation of 

plots and charts based on the data contained in the active data file.  Only the graphing options that 

are valid for the active data window will be displayed. 

Help 

The Help menu provides an in-program help for the user concerning the operation of the software.  

In addition, the Help menu provides important information with regards to the software version. 

The screen shown here is the starting point for working with 

the units in the PQR Series.  Note that not all menus described 

above are shown as they become available at certain times - 

such as Graph menu appears only when a text report is open. 
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File Menu: 

The File menu contains options for using data files stored on the computer’s hard drive or a disk. 

Open 

Select the Open menu item to open a data 

log, detail report, or summary report that 

is stored on the computer’s hard drive or a 

disk from a previous download.  After 

specifying the desired file, the program 

will open a window that contains the data 

from the file.  Note that the file type must 

also be selected. 
 

This function can also be performed at any 

time by using the Open File command on 

the Quick Launch Toolbar. 

Close 

Select the Close menu item to close the active device data or graphical display window. 

Save 

Select the Save menu item to save the active data file to it current file name and location.  This 

function also can be performed by using the Save File command on the Quick Launch Toolbar. 

Save As... 

Select the Save As menu item to save the active data file to a new file name and location 

specified by the user. 

Print 

Select the Print option to send the present active window to a printer.  The selection of this 

menu item will cause a Print Dialog to be displayed for the user to select which printer to use 

and to specify the desired settings.  This function also has an icon in the Quick Launch Toolbar. 

Memory Files 

This program will keep track of the last four files that have been used, and keep their names and 

locations in memory.  To reopen any of these files, simply select the menu item with the desired 

file’s name.  The program will display the contents of the file in a new window. 

Exit 

Select the Exit menu item to close all windows and exit the program. 
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Edit Menu: 

The Edit menu contains various, standard text editing options.  This menu is only available when 

a text report is open. 

Cut 

Selecting the Cut menu item will remove the 

text that is selected in the PQR device text 

file of the presently active window.  The text 

will be stored in the clipboard of the 

computer for future pasting if so desired. 

Copy 

Selecting the Copy menu item will make a duplicate copy of the text that is selected in the PQR 

device text file of the presently active window.  The duplicate copy is stored on the clipboard of 

the computer for future pasting. 

Paste 

The Paste menu item takes the contents of the clipboard and inserts it at the present location of 

the cursor within the PQR device text document that is presently in the active window. 
 

The previous three function can also be performed at any time by using the Cut, Copy, and 

Paste commands, respectively, on the Quick Launch Toolbar.  The standard Control- text 

editing commands are also available. 

Delete 

The Delete option removes the text that has been selected in the PQR device text file currently 

in the active window.  The text is completely removed from the document and is NOT stored in 

the clipboard.  This function can also be performed by using the Delete Key at any time. 

 

 

To UNDO or REDO changes made to a document use the Control-Z and Control-Y text 

editing commands respectively. 
 

Note that in order for any file modifications to be effective in future graphical renderings the 

file must be resaved after these operations. 
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View Menu: 

The View menu provides items used to control what tools are visible and available to the user in 

the main program window.  These items aid the user in the operation of the PQR Host Software. 

Toolbar 

Select the Toolbar menu item to toggle the 

existence of the Quick Launch Toolbar.  The 

toolbar, located just below the pull-down 

menus, contains buttons for easily opening, 

printing, editing, and saving files. 

Status Bar 

Select the Status Bar menu item to toggle the 

existence of the status bar located at the 

bottom of the main program window.  The 

status bar displays the program’s current 

COM port and baud rate settings.  It also lists 

the computer’s current system time and date. 
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Settings Menu: 

The Settings menu contains items that allow the user to specify certain settings for 

communications between the software and the PQR device.  The menu also provides an interface for 

setting the PQR device parameters. 

COM Ports 1 - 20 

The COM Port menu item is used to specify 

which computer COM port the PQR device is 

connected to.  The PQR Host Software scans 

the system and determines all available ports 

from 1 to 20.  Note that it is essential that 

other programs such as HyperTerminal not 

have control over the desired port as this will 

lock the PQR Software from that port until 

such time as control is relinquished.  Selecting 

one of the port options will change the 

program settings to that particular port.  The 

current settings are indicated by a check mark 

next to the port in use.  The current COM port 

setting is also displayed in the status bar at the 

bottom of the main program window. 

Set Date/Time 

Select the Set Date/Time menu item to set the device date and time used for data logging and 

event time stamping.  A dialog box will be displayed as shown here that provides the user an 

interface with which to specify 

the date and time.  The settings 

will be defaulted to the current 

date and time, or to the date 

and time specified previously 

in the same program session.  

When manually setting the 

Date and Time follow the input 

character format as specified in 

the section of the manual 

dealing with HyperTerminal 

Communications. 

 

After inputting the desired date and time, pressing the Okay button will instruct the program to 

set the device to the specified settings.  This process may take a few seconds. 
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Set Unit’s Baud Rate 

The Set Unit’s Baud Rate menu option 

allows the user to specify the data rate to 

be used when communicating with the 

device.  The program will display a 

dialog box with the seven valid baud 

rates to select from.  (Note only valid 

rates for the unit may be specified.)  The 

seven rates are: 1200, 2400, 4800, 9600, 

14400, 19200, and 38400.  After 

selecting the desired baud rate, pressing 

the Okay button will instruct the 

program to set the device baud rate.  

This process may take a few seconds.  

The program baud rate setting will also 

be set to the selected settings. 
 

When the rate is changed, the new 

setting is saved in FLASH RAM, and is 

used as the power up default until the 

next time the setting is changed. 

 

Set Data Logger 

The Set Data Logger menu item allows 

the user to specify the device data logging 

rate, or the time interval between data log 

samples.  The user will be provided six 

choices: 1 second, 5 seconds, 10 seconds, 

30 seconds, 1 minute, and 4 minutes.  

After selecting the desired logging 

interval, pressing the Okay button will 

instruct the program to change the device 

setting.  This process may take a few 

seconds. 
 

When the rate is changed, the new setting 

is saved in non-volatile RAM, and is used 

as the power up default until the next time 

the setting is changed. 
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Set Thresholds 

The Set Thresholds menu item allows the 

user to specify the thresholds at which the 

device will trigger events.  The user will be 

provided with a dialog box with input fields to 

specify the surge, sag, and power failure 

thresholds for all available lines.  Entering 

zero will set the unit to test at 5% and 10% 

limits.  Entering a value between 1 and 999 

will set the actual voltage for the unit to trip 

at.  Leaving a field blank will keep the 

threshold set to its current value.  To change 

the settings on a particular channel, simply 

click the Tab labeled with the channel name.  

After specifying the desired settings, pressing 

the Okay button will instruct the program to 

have the unit change its threshold settings.  

This process may take a few seconds. 

Set Host Baud Rate 

When a command is issued through 

the PQR Host Software the program 

will automatically cyclically attempt 

to located the unit on all available 

COM ports at each available Baud 

Rate.  This process begins at the 

previous settings used.  The Set Host 

Baud Rate option allows the user to 

m an u a l l y s e t  t h e  S ys t em ’ s 

communications baud rate to speed 

up this process. 
 

The Set Host Baud Rate option does 

not effect the baud rate setting of the 

device connected to the computer.  

Adjustments to that baud rate must be 

made using the previously discussed 

Set Unit’s Baud Rate. 
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Communications and Graph Menus: 

The Communications menu contains items that allow the user to retrieve data from the PQR 

device.  It also allows for clearing the unit and checking for proper channel operation.  The Graph 

menu lists the graphical representation options available to the user for the creation of plots and 

charts based on the data contained in a PQR device data file.  Only the graphing options that are valid 

for the active data window will be displayed.  Accordingly the Graph menu is only visible when a 

PQR device report is open. 

Together the Graph menu and Communications menus compose the core of the PQR Host 

Communications Software.  They provide the user with a means to access the data as well as the 

ability to view it in an understandable and useful format. 

The Communications menu, shown on 

the right, consists of the following 

communications options: 

Summary Report 

Detail Report 

Data Log  

Clear Unit’s Data 

Current Readings Mode 

 

The available graphs, corresponding to 

the three data files listed above, include the 

following which can be created using the 

PQR Host Software Graph menu items: 

Event Summary Chart 

Event Histogram Plot 

Time History Plot  

Additional information on each Communications Report/Graph pairing is available in the 

following pages. 
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Summary Report 

Selecting the Summary Report menu item will download a listing of counts for all the 

disturbances detected since the unit was put on-line and the RAM was last cleared.  Before 

starting the transmission, the user will be asked to specify the name and location of a file to 

save the data to.  This can include such details as the site name, customer, etc.  (Note the file 

will have a .srp extension.)  After the transfer is complete, the program will automatically open 

a text data window containing the downloaded data.  Each event is described by the channel, 

event type, and quantity of that disturbance for the channel. 
 

A sample summary report is shown below.  Note that the contents of the report will depend on 

the type of unit which is connected to the computer and PQR Software. 

Summary Chart 

Selecting the Summary Chart menu 

item from the now available Graph 

menu will cause a window to appear.  

This window allows the user to select 

which channels to include in the 

Summary Report chart.  Once a channel 

(or channels) with disturbance events 

detected on it is selected and the Okay 

button pressed, the PQR Host Software 

will generate a pie chart, from the 

summary report file open, showing the 

distribution of the detected events.  If no 

events are available the user will be 

notified and no plot will be created.  A 

sample pie chart display is shown here. 

Note the Summary Chart option is only available when a 

Summary Report file (.srp) is open and in the active window. 
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Detail Report 

Selecting the Detail Report menu item will download a listing of all the disturbances saved 

since the unit was put on-line and the RAM was last cleared.  Before starting the transmission, 

the user will be asked to specify the name and location of a file to save the data to.  This can 

include such details as the site name, customer, etc.  (Note the file will have a .drp extension.)  

After the transfer is complete, the program will automatically open a text data window 

containing the downloaded data.  Each event is described by the date and time, channel, event 

type, and magnitude. 
 

A portion of a sample detail report is shown below.  Note that the contents of the report will 

depend on the type of unit which is connected to the computer and PQR Software. 

Histogram Plot 

Selecting the Plot Histogram menu item 

from the now available Graph menu will 

cause a window to appear.  This window 

allows the user to select the events to be 

included in the Time Histogram from those 

available in the current Detail Report.  Once 

events have been selected and the Okay 

button pressed, the software will generate a 

histogram showing the total number of the 

selected events that occurred within each one 

hour interval of the report.  A sample 

histogram plot is shown here.  Note multiple 

hour increments must be available that 

contain the selected event types. 

Note the Histogram can be zoomed in on to target 

certain areas of interest (see Active Plot Zooming 

following the Data Log section).  Also the Histogram 

Plot option is only available when a Detail Report file 

(.drp) is open and in the active window. 
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Data Log 

Selecting the Data Log menu item will download a listing of the readings measured on all the 

input channels since the unit was put on-line and the RAM was last cleared.  Before starting the 

transmission, the user will be asked to specify the name and location of a file to save the data 

to.  This can include such details as the site name, customer, etc.  After the transfer is complete, 

the program will automatically open a text data window containing the downloaded data.  The 

contents of each entry in the data log report will include the date and time the reading was taken 

followed by each input channel and its readings. 
 

A portion of a sample data log file is shown below.  Note the channels vary between units.  

Also, the spacing between samples will be the data logging interval set in the unit’s memory. 

Time History Plot 

Selecting the Plot Time History menu 

item from the now available Graph 

menu will cause a window to appear.  

The window will list all available 

channels from the open Data Log report.  

The user may select one or two of the 

channels for plotting on the single Time 

History Plot.  After the user has made a 

selection and pressed the Okay button, 

the PQR Host Software will read in the 

data log file and create a plot of the 

readings for the selected channels.  A 

sample time history plot is shown here. 

Note the Time History Plot can also be zoomed in upon to 

target certain areas of interest (see Active Plot Zooming).  

Also the Time History Plot option is only available when a 

Data Log file (.dlg) is open and in the active window. 

Note that data in the file should have a constant time-stamp spacing of one data point per data 

logging interval (device setting).  See the following page for additional information on data 

gaps. 
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Active Plot Zooming 

The Detail Report Histogram Plot and the Data Log Report Time History Plot both support a 

zoom function for increased viewing capabilities.  To zoom in on a region in an active plot, 

simply use the mouse to click and drag over the desired region.  Upon release of the mouse 

button, the plot will redraw itself, expanding the selected region to fill the active window. 
 

For Data Log Time History Plots, in occasions where two channels are being plotted, there 

actually are two concurrent yet exclusive plots.  One is labeled on the left vertical axis the other 

is labeled on the right vertical axis.  The two plots can, however, be zoomed in on independent 

of each other.  Using the left mouse button to define a region using the click-and-drag 

procedure will zoom in on the data using the left axis.  Likewise, using the right mouse button 

will zoom in on the right axis data.  In either case, the time axis will be zoomed in on for both 

data sets.  For instance, if a user selects a region on a double plot using the right mouse button, 

in the resulting plot the left axis will remain unchanged but only the data points in the selected 

time range will be plotted. 

To return the plot to its initial 

view, double click the mouse in 

the plot region at any time. 

A sample two channel plot is shown here.  Note that AC1 is marked by the left vertical axis 

while AC2 is marked by the right vertical axis.  A zoom box is being placed over the AC1 data 

to zoom in on it as there is little change over much of the log file.  Note the zoomed in image 

below observing how the AC2 data remains at the same vertical scale.  A portion of the plot, 

after further zooming, is shown next to it. 
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Additional Notes on Graphing Data 

Note, in all of the above cases, if the program encounters incomplete or invalid data in the 

active data file, the user will be given the option of aborting the graphing procedure or viewing 

a graph of the data up to the erroneous data line.  These faults can be solved by deleting the non

-conforming data points until the consistent entries are reached.  The data must then be 

resaved (possibly as a new file) and then replotted. 
 

Also, in the course of unplugging a unit to bring it to a new location, the unit will often record 

power failures and other events that are not valid for the test site.  These are rather caused by 

arcing at the power connector as the unit is plugged in.  To solve this problem, the user can 

again simply delete these entries from the device text document and then save it - prior to the 

plotting.  Note that the time stamps will be helpful in the task of determining which events 

occurred in the initial and final moments of the test. 
 

It is also important to remember that anytime the unit is powered-up it restarts the data log 

record.  The implication of this is that when the unit is first moved to the site it will often have a 

single data log entry left from just after the last clear command.  This also will cause a gap in 

the time steps when the unit is unpowered and then powered again for the downloading of the 

data.  If gaps in the data are found, the PQR Host Software will assume it is due to a unit power 

down and the gap will simply be ignored in the plotting.  Note that these gaps can be eliminated 

using the same technique described above. 
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Clear Unit’s Data 

Selecting the Clear Data menu item from the Communications menu will clear all of the 

events and data log information stored in the internal FLASH RAM of the device.  The 

summary report quantities will be reset to zero 

and the data logging will restart the tracking of 

channel readings.  The program will ask the user 

for confirmation prior to transmitting the Clear 

command to the device.  Note that once this 

operation is performed the data previously stored 

in the unit is completely erased and is no longer 

recoverable! 

Current Readings Mode 

Selecting the Current Readings Mode item from the 

Communications menu will command the device to 

begin transmitting the current channel readings to the 

computer.  The channel readings are then displayed in a 

special window for the user to view.  The readings 

displayed will be updated approximately once per 

second (depending on the unit with which the software 

is in communication).  No other command can be 

performed while the program is in Current Readings 

Mode.  To end the transmission, the user must press 

the Stop button; otherwise, the transmission will self-

terminate after about four minutes. 
 

Note that this function is very useful when insuring that 

the signals under test are properly connected. 
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Help Menu: 

The Help menu provides in-program assistance to the user concerning the operation of the PQR 

Host Communications Software.  In addition, the Help menu also provides important information 

with regards to the Software Version, Release Type, etc. 

Help Topics 

Select the Help Topics menu item to initiate the in-program Help File provided for the 

PowerTronics PQR Series Host Communications Software.  This helpful subprogram is 

designed to supply a limited degree of assistance to users, as quickly as possible, as they work 

with the PQR Host Software. 

About PQRHost... 

Select the About PQRHOST… menu 

option to view the program 

information available for the PQR 

Host Software version being used on 

your system.  This notice will inform 

the user of the in-system name for the 

software as well as its technical release 

name.  It also contains the Software 

Version and Build numbers, both of 

which assist the user in maintaining the 

most up-to-date edition available.  

Such data may also prove helpful when 

speaking with the PowerTronics 

Technical Staff. 
 

Note that the latest software version is available on the PowerTronics website at 

www.PowerTronics.com.  Use the product support link and go to the Software Updates section. 
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Communication Notices: 

In communicating with a device via the PQR Host Software, various notices will often be 

returned to the user.  Some of the more common are discussed here. 

Check Baud Rate Error 

If for any reason the PQR Host Software is unable to contact the unit at the previously used 

COM port and baud rate settings it will begin to cycle through all available COM ports at each 

baud rate for the computer system searching for the 

device.  If it is able to locate the unit, the software will 

store these new settings as the new default for 

communicating with PQR devices on your system.  If, 

however, after searching through the available 

communications settings the software is still unable to 

locate the unit, it will return an error message like the 

one shown here. 
 

Note that if this occurs the most likely error is that the unit is either not connected properly or is 

not a unit capable of communication with the PQR Host Software.  Make sure that the unit is 

connected via a NULL modem cable (for direct connection, a Straight cable should be used 

when employing a modem) and that the unit is properly powered up, which can be confirmed 

by checking the status LED.  Also, make sure that no other programs such as HyperTerminal 

have captured the port the device is on.  Note that for the PQR Host Software to use a 

relinquished port, the port must be available when the software is first begun.  It may therefore 

be necessary to restart the program. 

Download Status 

Note that a large amount of downloading time may 

be necessary in certain cases where the data is 

transmitted from the device to the computer.  The 

exact duration is dependent upon the baud rate 

settings and the amount of data being download.  In 

these cases a status window, like the one shown 

here, will be displayed allowing the user to monitor 

the progress of the data transmission.  The status 

window shows a running count of the blocks 

written to the file during the current transmission.  The block count provides the number of 

lines of data that have been transferred.  Thus, by way of example, for a data log report the total 

number of blocks will be the number of data log entries that were recorded by the unit.  

Depending on the unit, the status window may also show the percent of the total download, of 

that report, that has been received up to that point.  The user can cut the transmission short by 

simply pressing the Cancel button in the status window. 
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HyperTerminal 

Communication with the PQR 2020 is also possible, without the use of the PowerTronics PQR 

Host Communications Software, using most other terminal emulation software including 

HyperTerminal.  This communication is performed on a command basis. 

Commands: 

The PQR 2020 will respond to commands received through the serial port. All commands are 

started with a C.  Entering C, followed by the command number will initiate the function 

corresponding to that command number. 

The commands for the PQR 2020 are as follows: 

 

C0 Transmit the Command Menu 

C1 Transmit the Unit Version Number 

C2 Transmit a Summary Report 

C3 Transmit a Detail Report 

C4 Transmit a Data Log of Recorded Readings 

C5 Clear all Events and Data Log 

C6 Configure the PQR Hardware 

C90 Continuous Transmission of Readings 

CX Hang up the Phone 
 

After the PQR 2020 has completed the task initiated by the operator command, it returns on-line 

to its monitoring duties.  Each of the commands for the PQR 2020 are detailed in the following 

pages. 
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Initial Transmission: 

When power is restored and the unit is connected to HyperTerminal, the user will receive a set of 

specific character lines.  These lines notify the user that the unit is going through its initialization 

routines and initialize the any modem which it may be connected to.  Commands may be entered 

once these lines have been output. 

Power up the unit. 

The PQR 2020 will respond with: 

Commands can now be entered into HyperTerminal and the unit will respond appropriately. 

 

+++AT&F 

AT S0=2 V0 E0 Q1 &G1 &K0 &D0 &S0 &Y0 &W0 

 

 PQR 2020 Ver VX.X   MMM/DD/YY  HH:MM:SS.ss 
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C0 - Transmit the Command Menu: 

This command will transmit the Command Menu back to the operator through the serial port. 

This is usually the first command to be issued when the operator is connected to the PQR 2020. 

Transmit or Type: C0, or CONNECT 

The PQR 2020 will respond with: 

This Menu can be called up any time the operator is connected to the unit, and the Menu is 

transmitted automatically upon receipt of the word CONNECT from a modem. 

 

PowerTronics  PQR 2020 Ver VX.X   MMM/DD/YY  HH:MM:SS.ss - ID: XXXXXX 

 

These are your Command Options: 

 

      C 0  - Display this Command List 

      C 1  - Display Unit Version Number 

 

      C 2  - Summary of all Detected Events 

      C 3  - Detail Report of Stored Events 

      C 4  - Data Log Report of all Channels 

      ESC  - Will STOP data transfer 

      SPACE  Will Pause data transfers 

 

      C 5  - Clear All Events 

      C 6  - Configure the PQR Hardware 

      C X  - Hang up 
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C1 - Transmit the Unit Version Number: 

This command will transmit the Model Name and Version Number back to the operator through 

the serial port. 

Transmit or Type: C1 

The PQR 2020 will respond with: 

The Version Number refers to the Firmware Program stored in the PROM located inside the unit. 

This number is needed whenever the operator contacts PowerTronics technical support specialists. 

 

PowerTronics  PQR 2020 Ver VX.X   ** PQR SERIES **   MMM/DD/YY - ID: XXXXXX 
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C2 - Transmit a Summary Report: 

Transmit or Type: C2 

The PQR 2020 will respond by transmitting a summary report.  The report is a count of all the 

disturbances detected since the unit was put on-line, and the RAM was cleared, categorized by 

channel and event type.  A sample summary report is shown below: 

Each entry is described by the channel on which it was detected, the event type, and the quantity 

of that event that occurred on that channel. 

Typing, or Transmitting the Escape character at any time will terminate the transmission of this 

report.  Typing, or Transmitting the Space character will pause the report.  The report will resume 

transmission after a brief wait or the user can request an immediate continue by re-transmitting the 

Space character. 

 

PowerTronics  PQR 2020 Ver VX.X - Summary Report as of MMM/DD/YY - ID: XXXXXX 

 

  Phase 1         Impulse, , ,2 

  Phase 1   Power Failure, , ,4 

  Phase 1   Power Restore, , ,5 

  Phase 1     Surge Start, , ,2 

  Phase 1  Surge Complete, , ,2 

 

  Phase 2         Impulse, , ,3 

  Phase 2   Power Restore, , ,1 

  Phase 2     Surge Start, , ,2 

  Phase 2  Surge Complete, , ,2 

 

  Phase 3         Impulse, , ,3 

  Phase 3   Power Restore, , ,1 

  Phase 3     Surge Start, , ,2 

  Phase 3  Surge Complete, , ,2 

 

  Neutral         Impulse, , ,6 
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C3 - Transmit a Detail Report: 

Transmit or Type: C3 

The PQR 2020 will respond by transmitting the Detail Report of all the disturbances saved since 

the unit was put on-line and the RAM cleared.  A portion of a sample detail report is shown below: 

Each event is described by the date and time of occurrence, the channel on which it was detected, 

the event type, and the magnitude of the event (if applicable). 

Typing, or Transmitting the Escape character at any time will terminate the transmission of this 

report.  Typing, or Transmitting the Space character will pause the report.  The report will resume 

transmission after a brief wait or the user can request an immediate continue by re-transmitting the 

Space character. 

 

PowerTronics  PQR 2020 Ver VX.X - Detail Report as of MMM/DD/YY - ID: XXXXXX:24 

 

MMM/DD/YY,  HH:MM:SS.ss,  Neutral         Impulse,  128,V Peak 

MMM/DD/YY,  HH:MM:SS.ss,  Neutral         Impulse,  88,V Peak 

MMM/DD/YY,  HH:MM:SS.ss,  Phase 3   Power Restore,  120,V 

MMM/DD/YY,  HH:MM:SS.ss,  Phase 2   Power Restore,  116,V 

MMM/DD/YY,  HH:MM:SS.ss,  Phase 1   Power Restore,  121,V 

MMM/DD/YY,  HH:MM:SS.ss,  Phase 1   Power Failure, 

MMM/DD/YY,  HH:MM:SS.ss,  Phase 1         Impulse,  149,V Peak 

MMM/DD/YY,  HH:MM:SS.ss,  Phase 1   Power Restore,  108,V 

MMM/DD/YY,  HH:MM:SS.ss,  Phase 1         Impulse,  381,V Peak 

MMM/DD/YY,  HH:MM:SS.ss,  Phase 2         Impulse,  195,V Peak 

MMM/DD/YY,  HH:MM:SS.ss,  Phase 3         Impulse,  194,V Peak 

MMM/DD/YY,  HH:MM:SS.ss,  Phase 1     Surge Start,  140,V 

MMM/DD/YY,  HH:MM:SS.ss,  Phase 2     Surge Start,  142,V 

MMM/DD/YY,  HH:MM:SS.ss,  Phase 3     Surge Start,  139,V 

MMM/DD/YY,  HH:MM:SS.ss,  Phase 2         Impulse,  93,V Peak 

MMM/DD/YY,  HH:MM:SS.ss,  Phase 3         Impulse,  209,V Peak 

MMM/DD/YY,  HH:MM:SS.ss,  Neutral         Impulse,  141,V Peak 

MMM/DD/YY,  HH:MM:SS.ss,  Phase 1  Surge Complete,  121,V 

MMM/DD/YY,  HH:MM:SS.ss,  Phase 2  Surge Complete,  121,V 

MMM/DD/YY,  HH:MM:SS.ss,  Phase 3  Surge Complete,  120,V 
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C4 - Transmit a Data Log of Recorded Readings: 

Transmit or Type: C4 

The PQR 2020 will respond by transmitting the listing of the voltages measured on all four AC 

Voltage inputs each data logger sampling interval since the unit was put on-line and the RAM 

cleared.  A portion of a sample data log report is shown below: 

The first line of transmission has a header listing the date of the unit at the time the Data Log was 

requested.  Also, following the serial number, the unit lists the total number of samples taken.  The 

following lines of the file are the values stored from the average readings tested during each interval.  

The data is listed in the following format: The date and time of each data log reading (at the sampling 

interval selected by the user with a default of one sample per minute) followed by the line voltages 

for Phases 1, 2 , and 3 and the Neutral channel during that interval. 

Typing, or Transmitting the Escape character at any time will terminate the transmission of this 

report.  Typing, or Transmitting the Space character will pause the report.  The report will resume 

transmission after a brief wait or the user can request an immediate continue by re-transmitting the 

Space character. 

 

PowerTronics  PQR 2020 Ver VX.X - Data Log Report as of MMM/DD/YY - ID: 

XXXXXX:1387 

 

MMM/DD/YY, HH:MM:SS.ss, AC1, 121,  AC2, 121,  AC3, 117, Neu,   2, 

MMM/DD/YY, HH:MM:SS.ss, AC1, 121,  AC2, 120,  AC3, 119, Neu,   2, 

MMM/DD/YY, HH:MM:SS.ss, AC1, 121,  AC2, 120,  AC3, 120, Neu,   1, 

MMM/DD/YY, HH:MM:SS.ss, AC1, 121,  AC2, 120,  AC3, 120, Neu,   1, 

MMM/DD/YY, HH:MM:SS.ss, AC1, 121,  AC2, 120,  AC3, 120, Neu,   2, 

MMM/DD/YY, HH:MM:SS.ss, AC1, 120,  AC2, 121,  AC3, 120, Neu,   2, 

MMM/DD/YY, HH:MM:SS.ss, AC1, 120,  AC2, 122,  AC3, 119, Neu,   0, 

MMM/DD/YY, HH:MM:SS.ss, AC1, 120,  AC2, 122,  AC3, 119, Neu,   2, 

MMM/DD/YY, HH:MM:SS.ss, AC1, 120,  AC2, 122,  AC3, 119, Neu,   2, 

MMM/DD/YY, HH:MM:SS.ss, AC1, 120,  AC2, 121,  AC3, 119, Neu,   1, 

MMM/DD/YY, HH:MM:SS.ss, AC1, 120,  AC2, 120,  AC3, 119, Neu,   2, 

MMM/DD/YY, HH:MM:SS.ss, AC1, 120,  AC2, 119,  AC3, 119, Neu,   2, 

MMM/DD/YY, HH:MM:SS.ss, AC1, 120,  AC2, 120,  AC3, 119, Neu,   2, 

MMM/DD/YY, HH:MM:SS.ss, AC1, 120,  AC2, 120,  AC3, 120, Neu,   2, 
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C5 - Clear All Events, and Data Log: 

This Command will clear all of the events and all of the data log information stored in the internal 

Flash RAM.  The Summary Report quantities will be reset to zero and the Data Logging will start 

over again with the tracking of channel voltage readings. 

Transmit or Type: C5 

The PQR 2020 will respond by transmitting the following message: 

Note that once the FLASH RAM has been cleared all Power Line data will be completely 

erased and will be lost!  There is no means of recovering the data from the unit once this operation 

has been completed. 

Entering any other character at the original prompt will cause the clear operation to abort.  The 

PQR 2020 will acknowledge the abort command by displaying the following: 

 

Are You Sure you want to CLEAR ALL DATA on this board ? _ 

 

Are You Sure you want to CLEAR ALL DATA on this board ? N 

Ram has NOT been cleared ! 

To proceed with the clearing of all data stored in the unit’s memory enter a CAPITAL Y.  The 

PQR 2020 will acknowledge receipt of the confirmation of the clear command and show erase 

completion by displaying the message shown below, followed by the initialization output. 

 

Are You Sure you want to CLEAR ALL DATA on this board ? Y OK 

 

Ram has been cleared ! 
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C6 - Configure the PQR Hardware: 

This Command will cause the unit to transmit the Setup Command Menu back to the operator 

through the serial port.  Selection may then be made of the desired setup option. 

Transmit or Type: C6 

The PQR 2020 will respond by transmitting the following setup options list: 

This Menu can be called up anytime the operator is connected to the unit.  Note that the Current 

Settings show how the PQR 2020 is configured at the present time. 

At the prompt enter the number of the setup option you wish to enter. This will allow you to set 

various options available for the PQR 2020.  Typing or transmitting the escape character at any time 

will cause the unit to exit the Setup Option menus. 

Type 1 to Set the Date and Time 

Type 2 to Set the Baud Rate 

Type 3 to Select a Sampling Rate for the Data Logger 

Type 4 to Set the Disturbance Thresholds 

 

The unit will then display the listings for the selected setup option.  Additional discussion of each 

option is made in the following pages. 

 

These are your Setup Options:                             Current Settings: 

 

   1  - Set the Date and Time                          MMM/DD/YY  HH:MM:SS.ss 

   2  - Set the Baud Rate                              19,200 Baud 

   3  - Select a Data Logging Sample rate              1 Minute 

   4  - Set the Sag, Surge, and Power fail thresholds 

 

  ESC - Exit this Menu 

 

Select an Option : _ 
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C6 - (Option 1) Set the Date and Time: 

This Command allows the operator to change the Time and Date setting inside the PQR 2020. 

Select Option 1: 1 

The PQR 2020 will respond by transmitting the following message: 

MM = Month Jan = 01, ... Dec = 12 

DD = Day 1st = 01, ... 31st = 31 

YY = Year 1995 = 95, 2001 = 01 

 

HH = Hour 1:00 AM = 01, 1:00 PM = 13 

MM = Minute 0 = 00, 59 = 59 

SS = Second 0 = 00, 59 = 59 
 

The data must be entered in the format shown, including commas, slashes, and colons. After 

entering the Time and Date, enter a Carriage Return. The unit will echo each character as it is 

entered.  If the format is correct the PQR 2020 will respond with: 

 

Input the Date and Time in the format MM/DD/YY,HH:MM:SS 

: _ 

 

Command OK 

Cancellation (by typing or transmitting the escape character) or an incorrect format will result in 

the unit responding with: 

 

Command terminated 
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C6 - (Option 2) Set the Baud Rate: 

This Command allows the operator to change the Communications Baud Rate setting inside the 

PQR 2020. 

Select Option 2: 2 

The PQR 2020 will respond by transmitting the following message: 

Typing the number indicated next to the desired rate will change the rate of the PQR 2020 

immediately to the new rate. The factory setting for the Baud Rate is 19,200 Baud. 

Note: Changing the baud rate breaks down the connection between the PQR 2020 and the 

communications device.  The baud rate of the communications device must also be changed in order 

to match the new rate of the PQR 2020.  To cancel the setting of the baud rate, type or transmit the 

escape character. 

When the rate is changed, the new setting is saved in non-volatile Flash RAM, and is used as the 

power up default until the next time the setting is changed. 

 

Select a Baud Rate       - Currently set to 19,200 Baud 

 

                       1) 1200     2) 2400     3) 4800 

                       4) 9600     5) 14400    6) 19200 

 

WARNING - You will need to change the rate on your terminal to match the PQR 

 

New Rate : _ 
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C6 - (Option 3) Select a Data Logger Sample Rate: 

This Command allows the operator to change the sampling interval for data logger readings 

stored inside the PQR 2020. 

Select Option 3: 3 

The PQR 2020 will respond by transmitting the following message: 

Typing the number indicated next to the desired sampling rate will change the sampling rate of 

the PQR 2020 immediately to that new rate. 

Note: When the rate is changed, the new setting is saved in non-volatile Flash Ram and used as 

the power up default until the next time the setting is changed. 

Upon entry of a number the PQR will respond (depending on the entry) with: 

 

Enter the number of seconds between Data log samples 

       1) 1 Sec    2) 5 Sec    3) 10 Sec 

       4) 30 Sec   5) 1 Min    6) 4 Min 

 

Any other choice sets rate to 1 Minute (default). 

 

New Rate : _ 

 

Enter the number of seconds between Data log samples 

       1) 1 Sec    2) 5 Sec    3) 10 Sec 

       4) 30 Sec   5) 1 Min    6) 4 Min 

 

Any other choice sets rate to 1 Minute (default). 

 

New Rate : 5 

Data Logger will now save 1 sample every 1 Minute 

Note that once the sampling interval is changed all data log entries stored in the unit will be 

cleared and permanently lost!  To prevent changing the data logger sampling interval, and erasing 

the data, type or transmit the escape character. 
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C6 - (Option 4) Set the Disturbance Thresholds: 

This Command allows the operator to change the threshold points for the PQR 2020 disturbance 

events. 

Select Option 4: 4 

The PQR 2020 will respond by transmitting the following message: 

To Set to a Fixed Threshold: 

Type the desired setting number.  For example, to set the Phase 1 Surge Threshold to 130 volts 

simply type 130 at AC 1 - Surge Threshold .... : (5%,10%) .. : followed by a carriage return.  

The PQR 2020 will respond with the entered value indicating the level at which it will now trip. 

To Set to Relative Thresholds (5% and 10%): 

Type the number zero.  For example, to set the Phase 1 Surge Threshold to trip at 5% and 10%, 

type 0 at AC 1 - Surge Threshold .... : (5%,10%) .. : followed by a carriage return.  The PQR 

2020 will respond with (5%, 10%) indicating it will now trip when the Phase 1 voltage is 5% and 

10% above the average RMS Phase 1 voltage. 

Note: The above transmission is performed line by line upon each entry by the user.  The break 

down is as follows: the PQR prompts for a given event type and gives the present threshold value.  

The user then enters the desired value and enters a return carriage.  The PQR 2020 will then echo that 

'new' value and prompts for the next event type.  Upon completion, the unit returns the following: 

 

Phase 1 - Surge Threshold ..... :  (5%,10%) .. : 0 (5%,10%) 

Phase 1 - Sag Threshold ....... :  (5%,10%) .. : 0 (5%,10%) 

Phase 1 - Power Failure ....... :  (5%,10%) .. : 0 (5%,10%) 

Phase 2 - Surge Threshold ..... :  (5%,10%) .. : 0 (5%,10%) 

Phase 2 - Sag Threshold ....... :  (5%,10%) .. : 0 (5%,10%) 

Phase 2 - Power Failure ....... :  (5%,10%) .. : 0 (5%,10%) 

Phase 3 - Surge Threshold ..... :  (5%,10%) .. : 0 (5%,10%) 

Phase 3 - Sag Threshold ....... :  (5%,10%) .. : 0 (5%,10%) 

Phase 3 - Power Failure ....... :  (5%,10%) .. : 0 (5%,10%) 

Typing or transmitting the escape character will terminate the setting of thresholds, saving those 

entries made up to that point.  Entering a Carriage Return without entering a threshold will cause the 

unit to retain the previously used threshold for that line entry.  The new threshold settings are saved 

in non-volatile Flash RAM and used as the power-up default. 

 

Setup Completed 
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C90 - Continuous Transmission of Channel Data: 

This command allows the operator to view the voltage readings present on each of the three 

Phases and Neutral of the PQR 2020. 

Transmit or Type: C90 

The PQR 2020 will respond by transmitting data similar to the following: 

The unit will send this reading continuously, resulting in the screen being updated about three 

times a second. 

This command is helpful in confirming the unit is properly connected to the signals under test. 

To quit the test, send any character to the unit, or wait for 4 minutes when the unit will return to 

the on-line testing mode on it’s own. 

Unit Off-Line, - entering Calibration mode 

 

Ph1: 116V   Ph2: 115V   Ph3: 115V   Neutral: 2V 

Ph1: 116V   Ph2: 115V   Ph3: 115V   Neutral: 2V 

Ph1: 117V   Ph2: 115V   Ph3: 115V   Neutral: 2V 

Ph1: 117V   Ph2: 115V   Ph3: 115V   Neutral: 1V 

Ph1: 117V   Ph2: 114V   Ph3: 116V   Neutral: 1V 

Ph1: 117V   Ph2: 114V   Ph3: 115V   Neutral: 1V 

Ph1: 117V   Ph2: 114V   Ph3: 115V   Neutral: 2V 

Ph1: 117V   Ph2: 114V   Ph3: 115V   Neutral: 2V 

Ph1: 117V   Ph2: 114V   Ph3: 115V   Neutral: 2V 

Ph1: 117V   Ph2: 114V   Ph3: 115V   Neutral: 0V 

Ph1: 117V   Ph2: 114V   Ph3: 115V   Neutral: 2V 

Ph1: 117V   Ph2: 114V   Ph3: 116V   Neutral: 2V 

Ph1: 117V   Ph2: 114V   Ph3: 116V   Neutral: 2V 

Ph1: 118V   Ph2: 115V   Ph3: 116V   Neutral: 1V 

Ph1: 116V   Ph2: 115V   Ph3: 117V   Neutral: 2V 

Ph1: 117V   Ph2: 115V   Ph3: 117V   Neutral: 1V 

Ph1: 117V   Ph2: 115V   Ph3: 117V   Neutral: 1V 

Ph1: 116V   Ph2: 115V   Ph3: 117V   Neutral: 1V 

Ph1: 116V   Ph2: 114V   Ph3: 116V   Neutral: 1V 

Ph1: 116V   Ph2: 114V   Ph3: 116V   Neutral: 2V 

Ph1: 116V   Ph2: 114V   Ph3: 115V   Neutral: 2V 

Ph1: 116V   Ph2: 114V   Ph3: 115V   Neutral: 2V 

Ph1: 116V   Ph2: 114V   Ph3: 115V   Neutral: 2V 

Ph1: 116V   Ph2: 114V   Ph3: 115V   Neutral: 2V 

Unit returning to On-Line mode 
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CX - Hang Up the Phone: 

This command allows the operator to disconnect the signal from a phone line on a modem 

attached to the PQR 2020. 

Transmit or Type: CX 

The PQR 2020 will respond by transmitting the following: 

Having sent this message, the unit then sends the hang-up command to the modem. If there is a 

modem connected, and it had the phone off-hook, it would put the phone on-hook. 

 

Thank you, and good bye. 

+++ATH0 
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AC Voltage Channels SpecificationsAC Voltage Channels SpecificationsAC Voltage Channels Specifications   

DATA LOGGING 

RMS Voltage Phase 1, 2, 3, and Neutral 
 Range: 80 to 480 V AC RMS 

 Resolution: 1 V RMS 

 Accuracy: +/- 1.5% 

 Sample Rate: Programmable - range of one reading per second 

  to one reading per four minutes 

 

THRESHOLD REPORTING 

Dropouts 
 Threshold: Programmable: User set values 

 Duration Limits: Longer than 8 ms, shorter than 80 ms 

 

Power Failure 
 Threshold: Programmable: User set values 

 Duration Limits: Longer than 80 ms 

 

Sags 
 Threshold: Programmable: User set values or 

  5% and 10% of average RMS 

 Duration Limits: 1 cycle or 20 ms 

 Accuracy: +/- 1.5% 

 

Surges 
 Threshold: Programmable: User set values or 

  5% and 10% of average RMS 

 Duration Limits: 1 cycle or 20 ms 

 Accuracy: +/- 1.5% 

 

Impulses 
 Range: 20 V to > 2500 V peak 

 Resolution: 5 V RMS (Impulse Magnitude Recorded) 

 Accuracy: +/- 10% 

 Pulse Detection: 500 ns above threshold 
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High Frequency Noise 
 Amplitude: 2 volts peak 

 Frequency: 10 KHz - 10 MHz 

 Accuracy: +/- 10% 

 Response Time: 1 ms 

 

Line Frequency 
 Range: 40 - 400 Hz 

 Accuracy: +/- 1% 

 Response Time: 1 AC cycle 

 Threshold: +/- 2% 
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Mechanical SpecificationsMechanical SpecificationsMechanical Specifications   
 Weight: 2 pounds 

 Size: 6.25" wide x 7" deep, x 1.75" high 

 Power Cord: 6 feet 

 AC Test Leads: Safety Banana/Alligator clip, 6 feet 

 Serial Comm. Cable: DB9F Null Modem, 6 feet 

 

Operating SpecificationsOperating SpecificationsOperating Specifications   
 Temperature: 30 - 120 degrees F 

 Humidity: 10% to 80% (non-condensing) 

 AC Voltage: 80 - 260 Volts AC 

 AC Current: 0.1 amps 

 Line Frequency: DC - 400 Hz 

 DC Voltage: 9 - 24 Volts DC 

 

Interface SpecificationsInterface SpecificationsInterface Specifications   
Serial Connector 

 Connector: DB9M - RS 232C (cable included) 

 Baud Rate: Programmable: 1200, 2400, 4800, 9600, 

  14400, 19200, or 38400 

  (Default to 19,200) 

 Protocol: 8 Data, 1 Stop, No Parity bits 

 

Data Storage SpecificationsData Storage SpecificationsData Storage Specifications   
 Summary Event Count: 32,750 total events 

 Detail Storage: 32,750 total events 

 Data Log Storage: 32,750 voltage readings (per channel) 

 Data Retention: FLASH RAM Data Storage, 

 Guaranteed 20+ years without power at 125º C 

 

Service SpecificationsService SpecificationsService Specifications   
 MTBF (Mean Time Between Failure) 26,000 hours 

 MTTR (Mean Time To Repair) 30 minutes 
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Types of Power Problems 
and what they look like. 

 

Over the recent decades, electronic components have been drastically reduced in 

size to produce increased speed and storage capacity. As a result of this decrease in 

size, these components have become many times more susceptible to AC power 

disturbances than similar devices of the past. PowerTronics knows this and has been 

working to increase awareness in the electronics industry by creating numerous 

power line monitors which will detect a wide range of power disturbances. 
 

There are many types of power problems that can affect the quality of the AC 

power being delivered to a piece of equipment. Different types of problems will 

have different effects on the operation, or even life expectancy of this equipment. 

Knowing what these problems are, and what some of the consequences are of having 

these problems, can help in the process of identifying what can be done to help 

protect this equipment. This section is designed to inform the user of some various 

power line disturbances. 
 

The following pages describe several of the more common types of power 

disturbances and list what some of the causes are. 

 

 Dropout/Power Failure 

 Sag 

 Surge 

 Impulse 

 High Frequency Noise 

 Common Mode Noise 

Typical AC Waveform   
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DROPOUT 
(NOTCH) 
 

A condition where a portion of the sine wave has a lower than expected value or is 

missing entirely, usually for a portion of a cycle.  These types of problems can be 

caused when large motors are started, Lightning arresters are employed (during a 

lightning hit), or when electrical equipment fails.  Dropouts can lead to failures in 

computers and electronic equipment , reduced life of motors and flickering lights. 

 

POWER FAILURE 
(BLACKOUT) 
 

When the duration of a dropout exceeds 1 cycle it is usually referred to as a Power 

Failure, or Blackout. A blackout is a reduction in RMS (Root Mean Square) line 

voltage below 80 volts for several cycles or longer, often recognized as a complete 

power failure for varying lengths of time. System hang-ups, data erasures, and 

erroneous data transfers often result from this problem. This problem is also the 

easiest to observe. 

Dropout 
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SAG 
(UNDER-VOLTAGE, DIP, BROWNOUT) 
 

A power sag (or low line voltage) is a decrease in line voltage of at least 10% of the 

average line voltage for half a cycle or longer. The power sag is often caused by 

large inductive equipment (e.g. photocopy, postage equipment) being applied on the 

same AC line as is being tested. Sags can be caused by external factors as well, such 

as large power draining equipment used in other buildings. Sags can be particularly 

detrimental to electronic equipment because of the malfunctions caused by the 

sudden decrease of available voltage to the power supply. Complete failure rarely 

occurs, and often the equipment user continues to operate the device, unaware of the 

potential logic circuit problems that may have occurred. 
 

A Brownout is a common example of a sag. Due to ever increasing demands for 

energy, brownouts are often intentionally caused by electric utilities as a method of 

conserving energy. Brownouts decrease the margin of voltage available to protect 

equipment from the effects of power sags. 

Sag 
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SURGE 
(SWELL, OVER-VOLTAGE) 
 

A power surge is the opposite of a sag and is often referred to as "High Line 

Voltage". A surge is defined as an increase in line voltage above 128 volts (on a 

115V Line) for a half cycle or longer. Like the sag, the power surge is often caused 

by large inductive loads being applied on the same line. Power surges cause some of 

the most dangerous occurrences, and their results are the most difficult to correct. 

Surge 
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IMPULSE 
(SPIKE, SURGE) 
 

The impulse is a surge of energy superimposed on the AC line, usually with a 

relatively short duration. Impulses can potentially have the most serious effects on 

electronic equipment due to their high energy content, and the Integrated Circuits 

inability to absorb the energy. Many events can cause impulses, such as lightning 

strikes, utility grid switching, switching inductive loads on and off, and SCR 

(Silicon Control Rectifier) dimmers. Although properly designed equipment has 

some built-in impulse protection, repeated hits by high energy impulses can 

eventually render these components useless. 

Impulse 
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HIGH FREQUENCY NOISE 
 

High frequency noise can be caused by electronic equipment feeding internal noise 

back onto the power line, or logic induced noise from switching power supplies. 

This noise is transferred to the AC line causing disturbances greater than 2V peak-to

-peak superimposed on the AC sine wave (normal mode noise). This noise can cause 

internal component degradation and eventual system failure. During this degradation 

period; system lockups, resets, and data transfer errors may increase. 

High Frequency Noise 
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COMMON MODE NOISE 
 

In single phase power systems, as found in many countries such as the USA, the 

load (computer or equipment) is connected between the Hot and Neutral lines. 

Usually the Neutral line is connected to Earth Ground at the service entrance, so that 

in effect the neutral line should have 0 volts at the load. However, at a typical site, 

voltage is induced onto the neutral line by other equipment. This voltage can appear 

in the form of impulses, or a continuous pseudo sine wave. 

Common Mode Noise 
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Power Conditioning 
And 

Power Protection Equipment 
 

PowerTronics has created numerous products designed to provide accurate, 

informative analysis of your AC power. As a result of such analysis you might 

discover that some sort of power conditioning and/or protective device may be 

necessary to extend the life of your electronic equipment and to save a lot of wasted 

time and money due to faulty power causing damage. This section is designed to 

introduce several power protection devices. In all cases, the user should contact a 

local power protection dealer before the purchase of any device. 
 

The following is a brief overview of several different types of power protection 

devices. 

 

 Switching Power Supplies 

 Spike and Surge Protectors 

 Power Line Filters 

 Computer Grade Transformers 

 Line Voltage Regulators 

 Power Line Conditioners 

 Uninterruptible Power Supplies (UPS) 

 Standby Power Supplies (SPS) 



PQR 2020PQR 2020PQR 2020   
Page   61 

www.PowerTronics.com 

SWITCHING POWER SUPPLIES 
 

The most basic defense against power disturbances is located right in the power 

supplies of most electronic equipment. These power supplies act as filters, 

“cleaning” the incoming AC and sending it to the components as DC power. Even 

though these power supplies can remedy many of the small AC disturbances and 

protect your equipment to a small degree, they cannot begin to filter everything the 

AC line has to offer. Repeated hits of spikes and noise will break down the 

efficiency of the minimal built-in power protection. 

 

 

SPIKE AND SURGE PROTECTORS 
 

By far the least expensive types of power protection, spike and surge protectors (or 

“clippers”) act by cutting off voltage when it exceeds a certain level and sending this 

offending voltage away from the sensitive circuits of electronic equipment. This 

excess voltage is sent to devices called Metal-Oxide Varistors (MOVs) which take 

the voltages and convert it to heat which dissipates over time. Whereas these surge 

protectors are good for short-term use and are inexpensive (usually under $50), the 

MOVs inside them degrade after a relatively short period of time due to repeated 

heating and cooling. Also, these protectors will function only as long as the voltage 

does not exceed the specifications of the components inside. 
 

There are basically two types of spike and surge protectors: tracking and non-

tracking. The difference between the two is that the tracking device will “clip” a 

spike to a certain limit anywhere on the sine wave whereas the non-tracking 

protector will clip a spike only when its magnitude reaches the clamping level, 

regardless of its position on the AC waveform. The tracking surge protector is the 

more expensive of the two. 

 

 

POWER LINE FILTERS 
 

Power line filters are designed to suppress spikes, surges, and noise before they get 

to the clipping level of common surge protectors. Instead of clamping the voltage 

when it exceeds the cutoff, the power line filter limits noise and spikes to a safe level 

by slowing down the rate of change of these problems, thereby keeping electronic 

systems safer than the surge protectors can. Of course, these filters are more 

expensive. 
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COMPUTER GRADE TRANSFORMERS 
 

These power protecting devices are multiple shielded transformers whose job is to 

suppress spikes and common mode noise. Although this seems much like power line 

filters, they are different in that they isolate primary and secondary AC, thereby 

establishing a safe and reliable ground for the electronic device they are protecting. 

Computer Grade Transformers are ideal for use when grounding is a problem 

because of an industrial environment. 

 

 

LINE VOLTAGE REGULATORS 
 

Voltage regulators maintain voltage to within a very narrow tolerance regardless of 

how much the AC line varies in terms of voltage. While these regulators offer some 

surge protection, they do not provide good isolation like computer grade 

transformers. 

 

 

POWER LINE CONDITIONERS 
 

These are excellent power protection devices as they are essentially a combination 

of computer grade transformers and line voltage regulators. They provide spike, sag, 

surge, and noise suppression while isolating the AC lines and providing an excellent 

system grounding point. 

 

 

UNINTERRUPTIBLE POWER SUPPLIES (UPS) 
 

These are the most complete power protection devices available. They operate by 

providing continuous, uninterrupted AC power from an isolated, regulated source 

regardless of the quality of the primary AC line. These power supplies are constantly 

supplying the system with clean AC power. Small UPSs contain built-in batteries 

which supply the system with DC power when a complete power failure occurs. 

Larger units use an external battery allowing for orderly shutdown of all systems 

during a power failure, or for activating backup generators. All UPSs provide very 

significant protection against all power problems, the better models approaching 

absolute protection. 
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STANDBY POWER SUPPLIES (SPS) 
 

These units differ from Uninterruptible Power Supplies in that the AC power is 

connected through a power line filter to the computer system. The SPS only begins 

to supply the computer with clean AC power when it senses a voltage interruption. 

At this time it activates an outside AC source and transfers its output to it. These 

SPSs are less expensive than UPSs, however, for most small systems they can still 

be used in place of a UPS and still gain the same benefits. The reason for this is that 

it takes only a few milliseconds for an SPS to switch to the alternate AC source, and 

most small systems do not notice this short gap without power. 
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PowerTronicsPowerTronicsPowerTronics   
Power Quality & Environmental Monitors 

Your Solution to Power Problems! 

 

When it comes to Power Quality, You Need Answers … 

With our equipment, you can get them! 
 

 

Since 1988, PowerTronics has been manufacturing 

tools to help identify and solve power quality related 

problems.  A wide range of power line monitors and 

data loggers are available directly from our 

PowerTronics website store or from our distributors 

and catalogs.  The following pages provide an overview 

of the available PowerTronics Devices for monitoring 

Power Quality and Environmental Conditions. 

For the very latest information, visit our website at: 

http://www.PowerTronics.com 
 

 

We support you, our customer, with on-line and telephone technical support.  You can email 

your reports to us and one of our service engineers will look at it and help you determine what 

your power problems are. 

 

You can reach us via email, phone, fax and mail.  We want to be your partner in problem 

solving!  For questions or concerns, please email us at info@PowerTronics.com or call us toll-

free at 1-800-746-9586.  We are there for you! 


